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Customer Support

Technical support is available from ProturaSupport@civco.com or by calling 866.851.4355 from 7 am to 6 pm CST, Monday through
Friday, excluding holidays.

Sales support is available at 800.842.8688.

About this Document

The notes and symbols used in this manual have the following meanings:

WARNING

e (alls attention to a procedure, practice or condition which, if not correctly performed or adhered to, could result in
injury or death.

NOTE Provides additional information or application hints.

Contact CIVCO to recycle per EU Directives.

Kontakt CIVCO vedrgrende genbrug i overensstemmelse med EU-direktiver.

Neem contact op met CIVCO voor recycling volgens EU-Richtlijnen.

Ota yhteys CIVCO:on koskien EU-direktiivien mukaista kierratysta.

Contacter CIVCO pour recycler le produit conformément aux directives européennes.
Zum Recycling nach EU-Richtlinien CIVCO kontaktieren.

EmkoivwvrioTe pe n CIVCO yia va diaBéoete oUppwva Pe Tig odnyieg Tng EE.
Contattare CIVCO per il riciclaggio secondo le Direttive EU.
JHATIVCEBLELTIZE UAREBE TTEIESZELY,

Ta kontakt med CIVCO for a gjennomfering av gjenvinning i henhold til aktuelle EU-direktiver.
Contacte a CIVCO para a reciclagem de acordo com as normas da UE.

IPE AR CTVCO LA JE R A 414 JEAT IR o

Contacte con CIVCO para el reciclado segin las Directrices de la UE.

Kontakta CIVCO for ateranvandning enligt EU-direktiv.

AB Direktifleri uyarinca geri dontstirmek igin CIVCO ile iletisime gegin.
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1 Protura

Validated Protura Configurations Safe Working Load
Varian Exact Base 372 Ibs. (169 kg) Universal Couchtop™ One Piece
Protura 359 Ibs. (163 kg) Universal Couchtop™ Long Extension
Universal Couchtop uniformly distributed
Elekta Precise 440 Ibs. (200 kg)

uniformly distributed
Siemens TXT 440 Ibs. (200 kg)

uniformly distributed

® Refer to accompanying document, Protura 1.5.0 Errata, for Validated Interface information.

INTENDED USE / INDICATIONS FOR USE

The Protura Couch is intended to support and aid in positioning a patient during radiologic, radiation therapy, and other
medical procedures. The Protura Couch adds Pitch and Roll to the normal X, Y, Z and Yaw motions. The additional
Pitch and Roll make patient alignment simpler without the need to manually move the patient on the table.

The Protura Couch Software is intended to interface between record and verify systems, linear accelerator (Linac) software
systems, Linac safeguard systems, and/or image guidance systems and the Protura Couch. The Protura Couch
Software is also capable of operating the Protura Couch (6 Degree Axis Couch).

The Protura Robotic Couch System is comprised of a robotic couch, a software package to control the motion of Protura,
and an alignment fixture to assure the software calculates where isocenter is with respect to Protura.

Protura enables the facility to deliver robotic corrections for treatments such as 3D Conformal, IMRT, SRS or SBRT.
Available interfaces include patient demographics, Linac Pedestal Location, IGRT move capture, and Remote Control.
Protura software stores shift data for each patient which can be printed or exported in PDF format.

Acceptance testing and regular QA is strongly encouraged to assure the product is performing to specifications.



1 Protura™

WARNING
f ® federal (United States) law restricts this device to sale by or on the order of a physician.

® Prior to use, read and understand all warnings.

®  Priorto use, review TG40', TG53? TG142° and other pertinent radiation therapy treatment standards and incorporate
those methods into your clinical practice to ensure accurate treatments and expected results.

Before use, you should be a trained radiation oncology medical professional.

e This product is intended for trained users of the Protura system. This product should not be used without a thorough
understanding of the general practice and guidelines regarding IGRT and 6DOF robotic treatment delivery. Personnel
should receive training prior to unsupervised operation of the system. For more information, contact Customer
Support or your local distributor.

e Do not operate Protura if device appears damaged. If problems exist, contact Customer Support or your local
distributor immediately.

® Protura software must be launched and running to enable all safety measures or precautions.

Ensure Protura is in a position suitable for treatment prior to initiating treatment of a patient.
When operating Protura from outside of treatment room, camera systems should be utilized to visually assure patient
safety.

e Al values imported from another system should be verified for accuracy.

The user is responsible for ensuring the application and use of the Protura does not compromise the patient contact rating
of any equipment used in the vicinity of, or in conjunction with, the system.

The use of accessory equipment and/or hardware not complying with the equivalent product safety and EMC requirements
of this product may lead to a reduced level of safety and/or EMC performance of the resulting system. Consideration
relating to the choice of accessory equipment used with this product shall include:

«  The use of the accessory in the patient vicinity.

+  Evidence the safety certification of the accessory has been performed in accordance with the appropriate IEC 60601-1
and/or IEC 60601-1-1 Harmonized National Standards

+  Evidence the EMC certification of the accessory has been performed in accordance to the IEC 60601-1-2 Harmonized
National Standards.

+  The original language of this instruction is English.

NOTE Observe all safety precautions recommended by the accessory equipment manufacturer in the user documentation provided
with the equipment.

Keep this manual with Protura for quick reference as required.

Comprehensive QA for radiation oncology: Report of AAPM Radiation Therapy Committee Task Group 40. Medical Physics 21(4), 1994.

ZAmerican Association of Physicists in Medicine Radiation Therapy Committee Task Group 53: Quality assurance for clinical radiotherapy treatment
planning. Medical Physics 25(10), 1998.

STask Group 142 report: Quality assurance of medical accelerators. Medical Physics 36(9), September 2009.
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. Getting Started

2.1 Hardware Overview

©

|. Buttons

I On button (Green):

Turns system on. The light will be lit if the system has power applied. When the On button is pressed, it will light up and
Protura will begin to reboot. Once Protura is ready to use, the green LED will light up. The system takes approximately
25 seconds to reboot. Protura will need to be initialized prior to use.

Off / STOP button:
Turns Protura hardware off. This can be used to stop Protura in case of an emergency.

Load / Unload button:
Moves Protura to the Load / Unload position to make it easier for patients to get on and off the couch pedestal. Load
position height is 5¢cm below the Zero position. Load / Unload button must be held for one second to activate the
move and prevent an unintentional move.

Zero Position button (Blue):
Moves Protura to Zero Position. When in Zero Position, Protura can be calibrated and given direct commands to
move based on IGRT results. Zero Position button must be held for one second to activate the move and prevent an
unintentional move. This button can also be used to initialize Protura. When Protura is in Zero Position, this button will
be it blue.

Use Off/ STOP button to stop Protura in case of emergency.

Power Off / STOP button turns Protura hardware off, not the power supply.

Take care to avoid pushing Load / Unload or Zero Position button unintentionally.

If persistent re-initialization messages occur, restart the Protura software and hardware. If problems continue, contact
Customer Support or your local distributor.

=

NOTE When system is first turned on, Protura must go to Zero Position before going to Load / Unload.
In the Load / Unload position, Protura must return to Zero Position before initiating patient movements.
When emergency stop is configured, the system emergency stop will stop Protura once activated.

3



2 Getting Started
Il. Lights

® O
+ O

Error light (Red):

| Indicates system error. User should examine Protura software for more specific indications of error code being received.

° If light is on while patient is on the couch, move Protura to Zero Position and then to Load / Unload position. If Protura
does not respond, press Off / STOP button to turn off and press On button to reboot. If the light comes back on after
Protura has rebooted, contact Customer Support or your local distributor immediately.

Motion light (Yellow):
‘-I-’ Indicates Protura is in motion.

Ready light (Green):
Indicates Protura system has booted properly and is ready to accept commands. It is possible for the On button to be
on but the Ready light to be off.

WARNING
f e Do not operate Protura in the event of software warnings or rear panel Error light is lit to indicate a system error.




2 Getting Started

2.1.1 Range of Motion

Protura software controls the Protura Robotic Couch system. This software/hardware combination allows for highly-accurate
patient positioning for targeted treatment.

Prior to using Protura, the system must be configured for use. Start by accessing the System Settings window (refer to
Section 8.1 System Settings).

Translation Ranges Rotation Ranges
+25.0mm +/-3.0°
+25.0mm +50.0mm /30
50.0mm -25.0mm
-25.0mm
NOTE Protura software limits rotational shifts to 5 degrees. Protura hardware may limit rotational shifts to 3 degrees or less based

on pivot point location and magnitude of other shifts. Prior to executing move, Protura will notify user if proposed move
request exceeds limits.

WARNING
f ® Take care when moving Protura or linac gantry to ensure patient and system collisions are avoided.

® Take care when moving Protura to ensure patient is immobilized as necessary.
e |f requested move exceeds Protura range of motion, refer to Section 5.2.5 Move Out of Range, for recommended
workflow. With updated shift, take verification image to ensure patient is aligned within treatment tolerance.



2 Getting Started

2.2 Software Overview

Main Menu Window. The Protura application main window includes:
. Main Menu Bar
Il. Patient Data Panel
lll.  Couch Position Panel
IV. Couch Button Panel
V. Status Area

Praotura
* File Tools Reports Help

MR Number: 1234567890-001
Patient Name: Smith, Michael

_
Edit Patient ="
IV O

Move Speed: [Tel=3 il Defauit (default) .

Current Couch Pedestal Location S Load / Unload
Unlock Pedestal Values

Zero Position
—
Manual Motion Rotation adjustment enabled

Proposed Values Current Values
VERT cm VERT  0.000 cm
LNG 0.5 eyl LNG 0.000 em

LAT 1.5 Kl LAT 0.000 cm

YAW deg YAW  0.00 deg

ROLL 0.2 LEh ROLL 0.00 deg

PITCH deg PITCH  0.00 deg

Couch is Stopped J
IGRT System: Default - Offsets - PRC

Version: Aligned: 11/2/2011 Protura connected

NOTE Every window in Protura allowing motion provides a STOP button. Be prepared to activate this during motion, if necessary.

. Main Menu Bar

Additional functionality is accessed in the Main Menu Bar. Options appear grey when unavailable or action is already
achieved.

Protura

File Tools Reports Help

File: Contains the ability to create new patient record, open patient record, close a currently loaded patient record, delete
patient record, import patient record and exit program.

Tools: Allows user to configure system, import configuration, export configuration, run a test procedure, align the pedestal,
or override an IGRT setting.

Reports: Generates patient reports.

Help: Provides Protura information.



2 Getting Started

|I. Patient Data Panel

MR Number: 1234567890-001
Patient Name: Smith, Michael Edit Patient

TR couse: Fed

Move Speed: Telz4ill Default (default) .

* MR Number: Displays Patient's MR Number. For MR Numbers exceeding 64 characters in length, the system will
display an ellipsis (...) to indicate the number has been truncated.

+  Patient Name: Displays patient's name. (Last Name, First Name) For patient names exceeding 30 characters in
length, the system will display an ellipsis (...) to indicate the data has been truncated.

+ Edit Patient button: Refer to Section 5.1.3 Edlit Patient Record.
+  Add button: Adds a course or field.

« Course: Course data is stored with patient data and available when patient is loaded. Refer to Section 5.1.4 Define
Course Identifiers.

+  Field: Field Identifier. This field accepts up to 30 characters. Field data is not stored with patient data. The value
entered here is written to the Move Report only (refer to Section 7.1 Daily Move Report and Section 7.2 Patient Move
Report).

«  Move Speed: Displays move speed of the currently-loaded patient. (Low, Medium and High)

+ IGRT: Refer to Section 8.3 IGRT Coordinate System Configuration.
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Getting Started

lIl. Couch Position Panel

This panel contains four distinct sections:

Keypad is accessible using a computer mouse or touch screen keys for changing field focus and adjusting field values.
Use the Import button to import patient information and IGRT data.

Current Couch Pedestal Location is used to capture current coordinates and rotation of the couch pedestal. Locking
the pedestal values sets the pivot point at isocenter in preparation for IGRT adjustments.

Manual Motion / Proposed Values is used to enter IGRT target coordinates or select Manual Motion button to manually
adjust position.

Current Values displays current Protura position. Current Values may not exactly match Proposed Values due to angle
order and pedestal rotation corrections.

+ 0.00 Values: Displayed prior to initiating motion.

+ Current Relative Positions: Displayed following successful motion.

* Red Double Dashes: Displayed when the current position of the couch is unknown.
(i.e., couch stops prior to reaching the set position).

Current Couch Pedestal Location
Unlock Pedestal Values

Manual Motion Rotation adjustment enabled

Proposed Values Current Values

VERT cm VERT  0.000 cm

NG [JIEE o LNG 0.000 cm
LAT ] o LAT 0.000 cm

YAW [ ces .00 deg

ROLL 0.2 JEh] 00 deg

PITCH deg .00 deg




2 Getting Started

IV. Couch Button Panel

This panel contains buttons to trigger couch movement.

Load 7 Unload

« Load/ Unload button: Moves Protura to the Load / Unload position to make it easier for
patients to get on and off the couchtop. Load position height is 5¢cm below Zero Position.
When in Load / Unload position, Protura must return to Zero Position before initiating
motion.

Zero Position

«  Zero Position button: Brings couch to the Zero Position. When in Zero Position, the
couchtop can be aligned and Current Couch Pedestal Location can be locked prior to
giving direct commands to move based on IGRT results.

+  Move button: Initiates motion based on IGRT results.

+  STOP button: Ceases Protura motion.

\/. Status Area

Located at the bottom of the main window.

+  Message Bar: Indicates Protura movement status.

Couch is Initializing

Couch in Motion

Couch is Stopped

Couch is Stopped Couch in Load/Unload Position ]

Touch Guard Activated Couch is Stopped Touch Guard Activated

Couch is Stopping

+  Status Bar:

IGRT System: Default - Offsets - PRC Version: Aligned: 5/2/2013 Protura connected

+ IGRT System: Data type (Offset or Absolute) and Pedestal Rotation Compensation, PRC when active (refer to
Section 8.3 IGRT Coordinate System Configuration).

*+  Protura Version information.

+  Couch Pedestal Alignment date.

+ Linac connection status, if applicable.

Version: Aligned: 5/2/2013 Linac Protura connected

+  Protura hardware connection status.
+  Remote Control connection status, if applicable.

e
Version: Aligned: 5/2/2013 Remote Protura connected
——

9



3 Alignment

3.1 Alignment Fixture

1. Unfold fixture.

Side view

o

2. Tighten thumb nuts. 3. Place alignment block.

4.

5. Ensure alignment fixture is properly seated on both sides and white is not visible at the junction of mount point on
alignment fixture prior to performing alignment.

10



3 Alignment

3.2 Isocenter Alignment

The Protura system features a virtual pivot point. Any corrections to the couch position (including pitch, yaw and roll) are
executed with the isocenter as the virtual pivot / reference point.

To set the virtual pivot point, Protura hardware must know where the isocenter is in relation to its own pivot point.

to assure there has been no drift over time can lead to inaccurate shifts and potential mistreatment. Since there are
no clear AAPM recommendations for couch pedestal to isocenter QA measurements, the user is advised to routinely
perform Protura alignment until the stability is assessed over time.

f ® Protura alignment assures the virtual pivot point will be calculated properly with respect to the linac isocenter. Failure

NOTE CIVCO strongly recommends the user calibrate their laser system prior to performing this procedure with Protura.
1. From the Tools menu, click Align Pedestal. This menu option is not available if a patient file is open.

Enter Password window displays. There are two methods to enter password.

* Enter password (default password is CeePro, refer to Section 8.1 System Settings). Click OK.
To leave Enter Password window without making changes, click Cancel.

Enter-Passward

Password: [

+ Click the keyboard icon. Enter password using a mouse or touch screen (default password is CeePro, refer to
Section 8.1 System Settings). Click OK.

Enter-Password

passuors: |

Cancel

11



3 Alignment

MR Number: _

Patient Name: Edit Patient = e

— o= s
Move Speed: (TS D fauilt (default)

To align couch pedestal, perform the following actions: Load / Unload
1. Set Protura to zero position.
2. Set the couch pedestal so that there is no rotation.

3. Attach the alignment fixture provided to the mounting points
on the Protura.

4. Move the couch pedestal to align the fixture markers with Zero Position
the lasers, at isocenter.

5. Use CBCT or other IGRT method to confirm that the system
is at isocenter.

6. Enter pedestal position information below.
Alignment Data

Last Alignment Date: Thursday, May 02, 2013 11:16:51

STT—
Update Alignment Date

Cancel

Couch is Stopped

. Click Zero Position.

Set couch pedestal so there is no rotation.

Attach alignment fixture (refer to Section 3.1 Alignment Fixture).

. Adjust pedestal (NOT Protura) so the IGRT block at the end of the fixture is aligned to room lasers or light field.
Perform kV image to verify IGRT block at isocenter.

Record pedestal position values in millimeters or centimeters (as defined in Section 8.3 IGRT Coordinate System
Configuration) into Protura alignment window. The location of the pedestal will be used from now on to calculate the
virtual pivot point location.

Click Update Alignment Date to update alignment date if the new calibration has the same values as the previous
alignment.

8. Click Save.

9. Exitand re-launch the Protura software.

o R WN

~
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Test Procedure

Test Procedure moves Protura hardware in 6DOF to test range of motion. The Test Procedure uses Protura Default Speed
(refer to Section 8.1 System Settings). Test Procedure may take several minutes to complete.

Prior to conducting Test Procedure:
+ Ensure the Protura is in a safe position.
+ Ensure patient record is not open.
+ Ensure there is no patient on couchtop.

1. From the Tools menu, click Test Procedure....
This procedure will test the movements of the Protura system.

The couch will move in all directions to the full extent of its
travel. Any errors will be reported.

Touch the Start button when ready.

Results

Cancel

2. Click Start to begin Test Procedure. Test Procedure to Begin message box will be displayed.

Test:Pracedure to Begin X

A This is a test procedure. Ensure there is not a patient on the couch. Click OK to
proceed or Cancel to abort the test.

Cancel

3. Click OK. Test Procedure begins.

13



4  Test Procedure

Test Procedure displays the current action.

Move to: 50,0,0,0,0,0

Moving... 1/20/2011 13:00:46

Results

Move to 0,0,0,0,0,0...SUCCESS

While Test Procedure is in progress, the Stop button may be used to stop Protura movement and end Test Procedure.

When Stop button is pressed, Protura will pause for 5 seconds. Test Procedure Aborted window will be displayed. Click OK
to move back to Zero Position.

Test: Pracedure Abaorted|

X
ﬂ The Test Procedure has been aborted. The Couch will return to the Zero position.

4. Once Test Procedure is complete, results will appear in the Results text panel.

NOTE

If Results show an error/failure, click Start to return Protura to Zero Position and run test procedure again. If Test Procedure
continues to fail, contact CIVCO Customer Service.

Results

Move to Maximum Rotation about Z..SUCCESS
Move to Minimum Rotation about Z...SUCCESS
Move to 0 Rotation about Z...SUCCESS3

Test Results for 1/20/2011 12:03:27...

All moves completed successfully.

Cancel

5. To close Results window, click Cancel.

14



h Using Protura

b.1 Managing Patient Information

Patient records can be created in advance of treatment or during import of IGRT data. Read and understand Sections 2
Getting Started and 3 Alignment before using Protura.

Protura can make corrections to 6DOF information to account for pedestal rotations. However, if IGRT system
already takes this into account before providing recommended shifts, correction in Protura is not needed.
e Execution of QA tests is required during Protura installation and IGRT system configuration to assure proper results.
Failure to do so can result in patient mistreatment. Always verify shifts through re-imaging and verification and IGRT.
® Protura does not account for patient movement. A confirmation image is recommended to ensure patient and target
are in the desired location before treatment is delivered.

f e |fpedestal rotation (couch kick) is desired for treatment, be sure to select and verify correct settings for IGRT system.

5.1.1 Create Patient Record

When creating a patient record, any value entered exceeding the maximum character limit will not be displayed. MR
Number, Last Name and First Name are required fields to save the patient record. Once data is saved, a tool tip is
available to display.

1. From the File menu, click New Patient... or select [Ctrl]+N on the keyboard.

New Patient

MR Number:

First Name:

(oL IEEMMNoNe selected - Add

Note: Once an MR Number is saved, it cannot be changed.

2. Enter MR Number. This field accepts up to 64 characters and is case sensitive.

NOTE The MR Number must be unique.
The MR Number cannot be changed once the patient record is saved.

Enter patient’s Last Name. This field accepts up to 30 characters.

Enter patient’s First Name. This field accepts up to 30 characters.

Course values are optional (refer to Section 5.1.4 Define Course Identifiers).

Click Clear to clear data from all fields, Save to save patient record, or Cancel to close the window without saving
changes.

Sk w
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5  Using Protura

b.1.2 Open Patient Record

1. From the File menu, click Open Patient... or select [Ctrl]+O on the keyboard.

2. Click column heading to sort patient list. Click column heading again to switch from ascending sort to descending

sort.

Patient List
Filter Patient List:
MR Number:

Last Name: First Name:

1 | =

First Name
Charles

Last Name “ MR Number
Brokenhorse 123-856-8954:Charles B
Coltrain 467-167-1287: Craig C
Doe 123-456-987::15

Doe 123-456-789:/:15

Doe 123-456-987:15

Jones 546-897-369:68

Current Data Directory:  C:\Documents and Settings\All Users\Documel

Load Cancel

3. Filter Patient List text boxes filters patient list to show only those records which contain value entered in

corresponding column. The filter text boxes can be used in combination.

For example, entering do in Last Name text box and jo in First Name text box, Patient List will filter these records:

Patient List

Filter Patient List:

First Name: MR Number:

Last Name:

e s |

First Name

John
John

Last Name “

Doe

Doe 123-456-987:15

16

Clear

MR Number
123-456-789:/:15



5  Using Protura

4. Select the row of the patient to be opened.
5. Click Load or double-click the patient to load into Patient Data Panel on the main window or click Cancel to close

the window without loading a patient.
6. After the patient is loaded, the Current Couch Pedestal Location values will be shaded with a red background and
values are black. If the patient has been treated before, the last couch positions used will automatically be loaded.

NOTE If the values are out of range, the Current Couch Pedestal Location values will be shaded with a red background and the
values will be white until corrected.

Current Couch Pedestal Location

Lock Pedestal Values

VERT LNG 1) Rotation
cm

LA
T - — ] —

7. These values must be confirmed as accurate before pedestal can be locked and movement can begin. Select each
field and update the value, if necessary. Click Lock Pedestal Values. When values need to be changed, click
Unlock Pedestal Values.

NOTE If Couch Pedestal Configuration thresholds are exceeded, a warning message will appear (refer to Section 12 System
Messages).

b.1.3 Edit Patient Record

1. Select Edit Patient from Patient Data Panel.

MR Number: 123-456-789:/:15
Patient Name: Doe, John Edit Patient

TRET couse rioc:

Move Speed: [el3 4|l Default (default) -

2. Update patient data as necessary.
* MR Number is a fixed field and cannot be edited.
* Click Clear to clear data from all fields.
* Course values are optional (refer to Section 5.1.4 Define Course Identifiers).

NOTE With Varian interface enabled, checkbox is available to indicate if Patient Treatment Uses Protura.

(V4TI 123-456-789:/:15

= Add

[oITCT C1

Patient Treatment Uses Protura

Note: Once an MR Number is saved, it cannot be changed.

Cancel

3. Click Save to save the patient record or click Cancel to close the window without saving changes.

17



5  Using Protura

5.1.4 Define Course Identifiers

Course identifiers can be defined when adding patient, editing patient, or through the main window after opening a patient.

1. Click Add.

New Patient

New Patient:

MR Number:

First Name:

(IEERMNone selected M Add

Note: Once an MR Number is saved, it cannot be changed.

Clear Save Cancel

MR Number: 123-456-789:/:15

Patient Name: Doe, John Edit Patient

Move Speed: [l plDfault (default) .

2. Entera Course value. This field accepts up to 30 characters and is case sensitive.

Add New Course

New Course:

Add Cancel

3. Click Add to add Course value to the Course drop-down list and close the window or click Cancel to close the
window without saving changes.

NOTE A course must be defined and selected to ensure patient setup is not outside of pedestal threshold value.
Once a course is added, it cannot be deleted or renamed.

4. Enter a Field value (optional). Field value will be stored with move data.

b.1.5 Close Patient Record
1.

From the File menu, click Close Patient. The patient data panel is cleared. Selecting Load / Unload button will also
close patient record if there is no active Remote Control connection.

NOTE Some application functions cannot be performed while a patient is loaded in the Patient Data Panel. For example, the
System Configuration settings cannot be changed until the Patient is closed.
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5.1.6 Delete Patient Record

1. From the File menu, click Delete Patient... or select [Ctrl]+D on the keyboard.

Patient List

Filter Patient List:

Last Name: First Name: MR Number:

Last Name * First Name MR Number
Brokenhorse Charles 123-856-8954:Charles B
i 467-167-1287: Craig C
123-456-987::15
123-456-789:/:15
123-456-987:15
546-897-369:68

Current Data Directory:  C:\Documents and Settings\All Users\Documel

Delete Cancel

Click the column heading to sort patient list. Click the column heading again to switch sort from ascending to descending.

Filter Patient List: Filters patient list to show only those records which contain value entered in corresponding column. The

filter text boxes can be used in combination. For example, entering do in Last Name and jo in First Name, Patient list
will filter these records:

Filter Patient List:

Last Name: First Name: MR Number:

o I -
Last Name First Name MR Number

Doe John 123-456-789:/:15

Doe John 123-456-987:15

2. Select patient(s) rows to be deleted.

Multiple contiguous rows can be selected by using [Shift]+click. Multiple non-contiguous rows can be selected by using
[Ctrl]+click.

3. Click Delete to delete selected patient record(s). A window will display to confirm deletion, click OK. Or click Cancel
to close the window without deleting any patients.

NOTE Deleting patient record(s) removes all history and recorded data for patients selected and cannot be recovered.
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b.2 Patient Moves

Protura is designed to accurately move patient to desired treatment position using IGRT data.

NOTE In order to be in a position to make corrections, the Protura MUST be moved to Zero Position BEFORE imaging is
performed. Protura is unable to make corrections from the Load / Unload Position.

In order to ensure patient does not move during treatment, CIVCO recommends patients be immobilized on couchtop. For
more information on immobilization products, please contact your local CIVCO representative.

b.2.1 Change IGRT System

The IGRT system can be changed from within a patient record.

1. In Patient Data Panel, select the IGRT system from the drop-down menu.

MR Number: 123-456-789:/:15

Patient Name: Doe, John Edit Patient

Move Speed: [elzy D efault (default) -

h.2.2 Change Move Speed

Current Move Speed can be overridden for a patient on a per-patient and per-treatment basis (refer to Section 8.1 System
Settings).

The overridden Move Speed value is stored with each patient move. When the patient is reloaded, the most recent Move
Speed value is used.

In Patient Data Panel, select desired Move Speed from drop-down list. The Move Speed values are Low, Medium and
High.

MR Number: 123-456-789:/:15
Patient Name: Doe, John Edit Patient

Add (oL 1IN one selected - Field: _

Move Speed: [el>yEDefault (default) -

NOTE Patients may react differently to the various speeds, work with your patient to select appropriate and comfortable speed.

Increased Move Speed may require more rigid immobilization, both for comfort as well as for assuring the patient is not
moved inadvertently.
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b.2.3 Couch Pedestal Location

1. Enter Current Couch Pedestal Location values.

Current Couch Pedestal Location

Lock Pedestal Values

ok Rotauu..

Awarning message will appear if values entered into Current Couch Pedestal Location exceed defaults set for thresholds

in Couch Pedestal Configuration tab from the patient's last move for the selected Course. Click Yes to proceed with
current values.

2. Click Lock Pedestal Values button.

Current Couch Pedestal Location
Lock Pedestal Values

VERT Rotation

3. When Pedestal Values are locked, the Move button becomes active.

b.2.4 Move Patient - Proposed Values

The Proposed Values section allows user to enter desired 6DOF adjustments for a patient move with Protura.

1.

Import or manually enter corrections into Proposed Values. Default values are zero. Changes will be displayed in
Current Values.

Current Couch Pedestal Location
Unlock Pedestal Values

Manual Matio, Rotation adjustment enabled

Proposed Values Current Values
VERT cm VERT 0.000 cm

LNG 0.5 K=yl 0.000 cm

LAT 1.5 =gl LAT 0.000 cm

YAW deg YAW 000 deg

ROLL [[F] deg ROLL 0.00 deg

PITCH deg PITCH 0.0 deg
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2,

Use Prev or Next to move focus to the first Proposed Values field or select field directly with mouse or by touching
field on touch screen display.

3. Enter target values with on-screen number pad or keyboard.

Increases selected value

Decreases S S S— D

eletes character to
se:ected - I & f AN € ¢t of cursor Manual Mation
value

Proposed Values

VerT [ cm
NG [ cm
a7 D

Yaw [ <eo
Changes sign of ROLL deg
— [ o]

selected value

PITCH ] deo

T 1

Changes selected field
4. Click Move.

WARNING

When a relative move is interrupted, the Proposed Values do not reflect the remaining move position. Users must
confirm the patient is in the correct position prior to starting treatment.

b.2.5 Move Qut of Range

Protura will determine if coordinates defined in Proposed Values are reachable based on current Protura and pedestal
position. If Proposed Values are not reachable, a message is displayed and the move is canceled. If the move is
canceled, the patient needs to be repositioned and new IGRT coordinates calculated.

Move Out of Range

)’( The proposed move exceeds limits. Please reposition the patient and try again.

OK
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b.2.6 Move Patient - Manual Motion

Manual Motion uses selected IGRT coordinate system settings for direction.

1. Click Manual Motion to manually set values.

Manual Maotion Rotation adjustment enabled

Fiopoin? YV llues Current Values

VERT [ cm VERT 0.000 cm

NG [ o LNG  0.000 cm
LAT [ o LAT  0.000 cm

yaw ] ceo YAW  0.00 deg
RoLL ] <eo ROLL  0.00 deg

PITcH [ oo PITCH  0.00 deg

2. Use arrows to manually move Protura and change values. Changes will be displayed in Current Values.

Proposed Values Rotation adjustment enabled

Ylliual v, Current Values

VERT VERT 0.000 cm

LNG LNG 0.000 cm

LAT LAT 0.000 cm

0.25 deg
-1.50 deg

-1.00 deg

NOTE During manual motion, the system is designed to not allow the screen to be minimized or closed. If the user decides to
minimize or close the screen, you must exit Manual Motion by clicking Proposed Values.

3. When move is completed, click Proposed Values.

Proposed Values Rotation adjustment enabled

MMannal Matin-

Current Values

VERT VERT 0.000 cm

LNG LNG 0.000 cm

LAT LAT 0.000 cm

0.25 deg

-1.50 deg

-1.00 deg
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b.2.71 Move Successful

A confirmation message will be displayed at the completion of each successful move.

1. Move Successful message window will be displayed. Click Yes if patient is ready for treatment. Click No to return to
Current Couch Pedestal Location panel to make additional adjustments.

Move Successful

ﬂ The move was successful. Is the patient ready for treatment?

Yes No

2. If Yes s selected, Ready for Treatment message window will be displayed and Protura is locked for treatment.

Ready forTreatment X

®| Ready for Treatment, system is Locked. To exit treatment made, click UNLOCK.

UNLOCK

3. When treatment delivery is complete, click UNLOCK.
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6.1 General Protura Workflow

This section details workflow for general positioning for treatment without linac integration.

XD =

If pedestal is moved prior to a secondary shift, rotations will not occur about isocenter.

With Protura in Load / Unload position, open patient in Protura system.

Filter Patient List by First Name, Last Name and/or MR Number and select patient record. Click Load.
Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.
Move Protura to Zero Position.

Zero Position

Move pedestal into treatment position using laser marking system, noting pedestal X Y Z coordinates.

Select each field of Current Couch Pedestal Location screen to enter coordinate value or to confirm displayed
value from previous treatment.

Select Lock Pedestal Values to confirm pedestal coordinate values.

Lock Pedestal Values

Current Couch Pedestal Location

VERT LNG LAT Rotation

ol syl ol oL

Exit treatment room.

Use IGRT system to calculate necessary shifts to place target at desired location. Enter values into Protura.

—
Manual Motion Rotation adjustment enabled
Proposed Values Current Values

VERT -3.3 ulyl VERT 0.00 mm

LNG mm LNG  0.00 mm

LAT 3.7 Ruly LAT 0.00 mm

YAW m deg 0.00 deg
ROLL deg 0.00 deg
PITCH [ ces 0.00 deg
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if ®  Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

NOTE

10. Click Move button to move Protura into treatment position.

11. Move Successful message will be displayed. Click Yes to lock Protura for treatment.

Move Successful

o The move was successful. Is the patient ready for treatment?

Yes No

A confirmation image is recommended to ensure patient and target are in the desired location before treatment is delivered.

12. Ready for Treatment message will be displayed. System is now locked and ready for treatment.

Ready for-Treatment X

@ Ready for Treatment, system is Locked. To exit treatment mode, click UNLOCK.

UNLOCK

13. Follow protocol for treatment delivery.

14. Upon completion of treatment, enter treatment room.

15. Select UNLOCK in Protura software.

16. Select Load / Unload button. Protura will move to Load / Unload position and automatically close patient record.

Load / Unload

17. Patient may exit treatment room.

18. Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6.2 Protura Workflow - Varian Integration

This section details workflow with Varian integration and 6DOF with Protura. In the Varian Interface tab, Division of
Movement must be set to 6DOF with Protura. Refer to Section 8.5 Varian Interface Settings.

NOTE

e Execution of QA tests is required following any updates to Varian 4DTC, OBI, ARIA, or MOSAIQ systems. Verify shift
values calculated by Protura match the shifts generated in the OBI System.

e When making Protura shifts with Varian interface enabled, do not Apply Shifts to pedestal with the OBI System or
other non-Protura systems. Protura will not update with new pedestal location, thus rotations will not occur at room
isocenter and double shifts are possible.

Ensure patient record in Varian 4DTC System matches patient record in Protura.
Treatment authorization to Varian 4DTC System will remain active until Clear Mode Up is selected.

1. With Protura in Load / Unload position, open patient in Varian 4DTC System or MOSAIQ.
* If selected patient exists in Protura database, patient record will automatically launch in Protura.
* If selected patient does not exist in Protura database, New Patient message will be displayed. Click Yes to
indicate patient will be treated using Protura. Patient record will be added to Protura and will automatically
launch.

@ Is the new patient to be treated using the Protura System?

If patient is not treated with Protura, refer to Section 6.4 Protura Workflow - Varian Integration without Protura.

2. InVarian 4DTC System, Mode Up the setup field.
3. Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.
4. Move Protura to Zero Position.

Zero Position

5. Align patient to external markers.
6. Exit treatment room.
7. Calculate shifts with OBI System to align target.
8. In OBI System, click Save Match and shift values are saved.
Couch Position (VAR IEC Scale, All units in cm and degrees) and Shift
Raw Shift Values —Machine Values Reset Shift
SHIFT SHIFT TARGET ACTUAL SHIFT
Gouch Vrt -05 Couch Pitch -1.0 Couch Vit 12.0 125 -0.58 ¥ Include
Couch Lng +0.4 Couch Roll +0.A Couch Lng 140.4 140.0 +0.4 % Include Sl Mot )
Couch Lat +03 Couch Rin 09 Couch Lat 0.2 0.0 +0.3 v Include SERICL
Couch Proj Rin Couch Rin 3591 0.0 -09 ¥ Include
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NOTE Protura software calculates shift values, gets pedestal location from the Varian 4DTC System (with a pedestal 0,0,0 move
request), and locks the pedestal in Protura software.
9. Protura displays shift values and Move button becomes available.
WARNING

f ® Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

NOTE

10. Click Move button to move Protura into treatment position.

11. Move Successful message will be displayed in Protura system. Click Yes to lock Protura for treatment.

Move Successful

o The move was successful. Is the patient ready for treatment?

Yes No

A confirmation image is recommended to ensure patient and target are in the desired location before treatment is delivered.

12. Ready for Treatment message will be displayed. System is now locked and ready for treatment.

Ready for-Treatment X

@ Ready for Treatment, system is Locked. To exit treatment mode, click UNLOCK.

UNLOCK

13. In OBI System, click Cancel and select No to apply shifts.

SHIFT
-04 W Include Modified couch shifts
| [ Include w :
03 ; ' E Do you want to apply couch shifts?
-0.1 W Include Apply Shift <
+08 M Include | ( Mo )

I o | 2 v o
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NOTE

14. In Varian 4DTC System, click Cancel to pedestal move request 0,0,0, which is sent from Protura to access pedestal
location. Select Yes to cancel pedestal shift request.

Apply Couch parameters

The folowing couch parameters have been modified:

Couch Parameter Target Position Offset
Couch ¥rt 999.6 (cm) 0.4 (cm)
Couch Ling 139.7 (crm) 0.2 (crm) 4D Console
Couch Lat 0.1 (cm) 0.1 (em)
Couch Rin 0.0 (deg) Are you sure you want to cancel applying/ acquiring couch
. corrections?
Couch corrections wil be applied to all the selected figlds from the
list below.
‘ Yes ’ MNo
Field ID | Field Name [socenter(x,y,z) (cm) ]
KVRT... KVRTLAT 0.00, 0.00, 0.00 |
KW AP K& AP 0.00, 0.00, 0.00
My LT... MW LT LAT (.00, 0.00, 0.00
=
<

YT Y AD R St [aNalalaNa'aBaNa's} o

|

C e )

S

15. In Varian 4DTC System, Mode Up treatment field.

Protura will lock during treatment with no option to unlock. Unlock option will be available at completion of each treatment
field.

fﬁ Treatment may be in Process and system is Locked. This window will close when the
~ field is closed.

16. Follow treatment delivery protocol.

17. Repeat STEPS 15-16 for all treatment fields.

18. Close patient in Varian 4DTC System and/or MOSAIQ.

19. Enter treatment room.

20. Select UNLOCK in Protura.

21. Select Load / Unload button. Protura will move to Load / Unload position and automatically close patient record.

Load / Unload

22. Patient may exit treatment room.

23. Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6.3 Protura Workflow - Varian Integration with Pedestal Shifts

This section details workflow with Varian integration when Protura software applies shifts to Protura hardware and Varian
pedestal. Division of Movement configuration must be set to Translation Pedestal / Rotations Protura OR
Translation and Yaw Pedestal / Pitch and Roll Protura. Refer to Section 8.5 Varian Interface Settings.

values calculated by Protura match the shifts generated in the OBl System.

e When making Protura shifts with Varian interface enabled, do not Apply Shifts to pedestal with the OBI System or
other non-Protura systems. Protura will not update with new pedestal location, thus rotations will not occur at room
isocenter and double shifts are possible.

If requested pedestal move is applied from Protura system, secondary shift rotations will not occur about isocenter.
Ensure patient record in Varian 4DTC System matches patient record in Protura.
Treatment authorization to Varian 4DTC System will remain active until Clear Mode Up is selected.

f\- e Execution of QA tests is required following any updates to Varian 4DTC, OBI, ARIA, or MOSAIQ systems. Verify shift

1. With Protura in Load / Unload position, open patient in Varian 4DTC System or MOSAIQ.
* If selected patient exists in Protura database, patient record will automatically launch in Protura.
« If selected patient does not exist in Protura database, New Patient message will be displayed. Click Yes to
indicate patient will be treated using Protura. Patient record will be added to Protura and will automatically
launch.

New Patient

@ Is the new patient to be treated using the Protura System?

NOTE If patient is not treated with Protura, refer to Section 6.4 Protura Workflow - Varian Integration without Protura.

2. InVarian 4DTC System, Mode Up the setup field.
3. Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.

4. Move Protura to Zero Position.

Zero Position

5. Align patient to external markers.
6. Exit treatment room.
7. Calculate shifts with OBI System to align target.
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8.

In OBI System, click Save Match and shift values are saved.

Couch Position (VAR IEC Scale, All units in cm and degrees) and Shift

Raw Shift Values

Values Reset Shift
SHIFT SHIFT TARGET ACTUAL SHIFT
Couch Vrt -05 Couch Pitch -1.0 Couch Vit 12.0 125 -05 ¥ Include
Couch Lng +04 Couch Roll +05 Couch Lng 140 4 1400 +0.4 ¥ Include Sl
Couch Lat +03 Couch Rtn 09 Couch Lat 03 00 +0.3 ¥ Include i
Couch Proj Rtn Couch Rtn 3591 00 -09 ¥ Include

NOTE

Protura software calculates shift values, gets pedestal location from the Varian 4DTC System (with a pedestal 0,0,0 move
request), and locks the pedestal in Protura software.

9. Protura displays shift values and Move button becomes available.

WARNING

® Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

10. Click Move button to move Protura and send shift data to Varian 4DTC System.

Verify pedestal position matches Protura move request.

Apply Couch parameters

The following couch parameters have been modified:

Couch Parameter Target Position Offset
Couch ¥rt 999.6 (crm) 0.4 (cm)
Couch Lng 139.7 (cm) Q.3 (em)
Couch Lat 0.1 {cm) 0.1 (em)
Couch R 0.0 {deg)

Couch corrections wil be applied to &l the selected fields from the
izt below,

Field ID | Field Name Isocenter(x,y,z) (cm) A
KVRT... KVRTLAT 0.00, 0.00, 0.00
KV AP KV AP 0.00, 0.00, 0.00
MV LT... MVLTLAT 0.00, 0.00, 0.00
IRy AD WV Sah i AAN AN AN 4
<

: Apply Cancel
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11. In OBI System, click Cancel and select No to apply shifts.

Reset Shift |
SHIFT
04 W Include Modified couch shifts

; Includ Save Match | .
03 ¥ Include Aoply Shit | ! E Do you want to apply couch shifts?
01 W Include :

_ 1 Acquire | 2 Analyze (@@ Cancel
12. In Varian 4DTC System, click Apply to move pedestal with shifts sent from Protura.

The folowing couch parameters have been modified:

Couch Parameter ‘ Target Position | Offset |
Couch vt 999.6 {cm) 0.4 {cm)
Couch Lng 139.7 (cm) 0.3 (em)
Couch Lat 0.1 (cm) 0.1 (em)
Couich Rt 0.0 {deg)

Couch corrections wil be appled to all the selected figlds from the

list below.
\ Field ID | Field Mame \ [socenter(x,y,2) (cm) ]
KV RT... KVRTLAT 0.00, 0.00, 0.00
KW AP KV AP 0.00, 0.00, 0.00
MY LT... MVLTLAT 0.00, 0.00, 0.00
(l:| MV N D kM Catom non nonn Oon | 5 )

e —

ey ) cance
—

13. In Varian Clinac, press Motion Enable and >> keys to update pedestal position.

B i-c AT Yt A% am  CRICU DT

14. Move Successful message will be displayed in Protura system. Click Yes to confirm pedestal shifts have been
made and to lock Protura for treatment.

\/i-\ The move was successful. Have pedestal shifts been accepted in the 4DTC and is the
e patient ready for treatment?

No

NOTE A confirmation image is recommended to ensure patient and target are in the desired location before treatment is delivered.
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NOTE

15. Ready for Treatment message will be displayed. To exit treatment mode, click UNLOCK.

Ready/for-Treatment X

® Ready for Treatment, system is Locked. To exit treatment mode, click UNLOCK.

UNLOCK

16. In Varian 4DTC System, click Clear Mode Up, then Mode Up treatment field.

Protura will lock during treatment with no option to unlock. Unlock option will be available at completion of each treatment
field.

m Treatment may be in Process and system is Locked. This window will close when the
~ field is closed.

17. Follow treatment delivery protocol.

18. Repeat STEPS 15-16 for all treatment fields.

19. Close patient in Varian 4DTC System and/or MOSAIQ.

20. Enter treatment room.

21. Select UNLOCK in Protura.

22. Select Load / Unload button. Protura will move to Load / Unload position and automatically close patient record.

Load / Unload

23. Patient may exit treatment room.

24. Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6.4 Protura Workflow - Varian Integration without Protura

This section details workflow using Varian 4DTC System only.

A ;

1.

© N o o

Ensure patient record in Varian 4DTC System matches patient record in Protura.
Treatment authorization to Varian 4DTC System will remain active until Clear Mode Up is selected.

With Protura in Load / Unload position, open patient in Varian 4DTC System or MOSAIQ.

« If selected patient exists in Protura database, patient record will automatically launch in Protura. Patient record
configuration must have “Patient Treatment uses Protura” unchecked. Refer to Section 5.1.3 Edit Patient
Record.

* If selected patient does not exist in Protura database, New Patient message will be displayed. Click No to
indicate patient is not being treated using the Protura System. Patient record will be added to Protura and will
automatically launch.

@ Is the new patient to be treated using the Protura System?

In Varian 4DTC System, Mode Up the set up field.
Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.
Move Protura to Zero Position.

Zero Position

Align patient to external markers.
Exit treatment room.
Calculate shifts with IGRT system to align target.

Position patient as needed for treatment:
* Apply shifts through pedestal.
* [f patient is rotated, use method other than Protura to correct rotations.
* Re-enter room to reposition patient, re-image patient with updated location.

Repeat STEPS 7-8 as needed for accurate patient positioning.
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NOTE

6.5 Protura Workflow - Elekta Integration

10. In Varian 4DTC System, Mode Up treatment field.

Protura will be locked for treatment with no unlock option during treatment. Unlock option will be available at completion of
each treatment field.

® Treatment may be in Process and system is Locked. This window will close when the

field is closed.

11. Follow treatment delivery protocol.

12. Repeat STEPS 10-11 for all treatment fields.

13. Close patient in Varian 4DTC System and/or MOSAIQ.

14. Enter treatment room.

15. Select UNLOCK in Protura.

16. Select Load / Unload button. Protura will move to Load / Unload position and automatically close patient record.

Load / Unload

17. Patient may exit treatment room.

This section details workflow with Elekta, MOSAIQ and XV integrations with 6DOF with Protura. In this workflow, Protura
is able to monitor pedestal coordinates at all times. Define configurations in Elekta Interface tab (refer to Section 8.6

Elekta Interface Settings).

WARNING

A\

NOTE

® Ensure existing patient in Protura is closed prior to opening new patient in MOSAIQ.
® [f pedestal is moved prior to a secondary shift, rotations will not occur about isocenter.

1. With Protura in Load / Unload position, open patient in MOSAIQ System and patient record will automatically
launch in Protura.

2. Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.

3. Raise pedestal to align patient to external markers.
« If configuration is set to Auto Load / Zero, Protura will automatically move to Zero Position when pedestal
vertical and longitudinal coordinates meet the configured values. Refer to Section 8.6 Elekta Interface Settings.
* If not configured for Auto Load / Zero, use touch screen in vault to move Protura to Zero Position.

Current pedestal position is automatically updated and displayed in real time in Protura.
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4. Select Lock Pedestal Values in Protura.

Lock Pedestal Values

Current Couch Pedestal Location

VERT LNG LAT Rotauon
E

L) - ) - m [ deq

5. Exit treatment room.
6. Calculate shifts with Elekta XVI System to align target.
7. Save shifts in Elekta XVI System and shift values are automatically communicated to Protura.

WARNING

CE ®  Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

8. Click Move button to move Protura into treatment position.

NOTE For Rotations Only, refer to Section 8.6.4 Rotations Only.

9. Move Successful message will be displayed in Protura. Click Yes to lock Protura for treatment.

Move Successful

o The move was successful. Is the patient ready for treatment?

NOTE A confirmation image is recommended to ensure patient and target are in the desired location before treatment is delivered.

Protura configuration can be set to allow unlocking in treatment mode or the unlock feature can be disabled. Refer to
Section 8.6 Elekta Interface Settings.

10. Follow treatment delivery protocol.
11. Close patient record in MOSAIQ.
12. Enter treatment room.

13. Select UNLOCK in Protura.

14. Lower pedestal.
* If configuration is set to Auto Load / Zero, Protura will automatically move to Load / Unload position when
pedestal vertical and longitudinal coordinates meet the configured values and patient record will automatically
close.

15. Patient may exit treatment room.

16. Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6.6 Protura Workflow - Remote Control

This section details workflow for a Remote Control System (i.e. AlignRT) operating the Protura hardware.

WARNING

é e |fpedestal is moved prior to a secondary shift, rotations will not occur about isocenter.

1.

No o s~

With Protura in Load / Unload position, open patient in Remote Control System. Patient record will automatically
launch in Protura.

Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.
Raise pedestal and move Protura to Zero Position using buttons on Protura couch or via Remote Control System.

= g

Mowve Load Zero Stop

Protura WARNING nui at Zero

Align patient to external markers.

Exit treatment room.

Calculate shifts with Remote Control System to align target.
Click Move Protura in Remote Control System.

Mowve
Protura

Change values to reflect current position of pedestal to match Protura and click Apply in Remote Control System to
send current pedestal positions to Protura.

100.0cm
0.0cm
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9. Click Apply a second time to apply shifts in Protura.

10.

1.
12.
13.
14.

15.
16.

Click 'Apply' to send the delta move to the Protura

Pedestal Location Protura Deltas
0.0 cm
100.0cm
0.0cm

0.0°

Click Verify to confirm shifts were applied correctly.

Click 'Verify' to check if the move was correct
Pedestal Location Protura Deltas
0.0 cm
100.0cm
0.0cm
0.0°

Follow treatment delivery protocol.
Close patient in Remote Control System.
Enter treatment room.

Move Protura into Load / Unload position using buttons on Protura couch or via Remote Control System. Patient
record will automatically close.

Mowve Load Zero Stop

Protura WARNWING not at Zero

Patient may exit treatment room.

Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6./ Protura Workflow - Remote Control with Linac Integration

This section details workflow for a Remote Control System (i.e. Align RT) operating the Protura hardware with Linac
integration.

values calculated by Protura match the shifts generated in the OBI System.
e When making Protura shifts with Varian interface enabled, do not Apply Shifts to pedestal with the OBI System or
other non-Protura systems. Protura will not update with new pedestal location, thus rotations will not occur at room
isocenter and double shifts are possible.
Ensure patient record in Varian 4DTC System matches patient record in Protura.
Treatment authorization to Varian 4DTC System will remain active until Clear Mode Up is selected.
Ensure existing patient in Protura is closed prior to opening new patient in MOSAIQ.
If pedestal is moved prior to a secondary shift, rotations will not occur about isocenter.
If requested pedestal move is applied from Protura system, secondary shift rotations will not occur about isocenter.

f e Execution of QA tests is required following any updates to Varian 4DTC, OBI, ARIA, or MOSAIQ systems. Verify shift

1. With Protura in Load / Unload position, open patient in Varian 4DTC System or MOSAIQ.

FOR VARIAN SYSTEM CONFIGURATIONS:
* If selected patient exists in Protura database, patient record will automatically launch in Protura.
* If selected patient does not exist in Protura database, New Patient message will be displayed. Click Yes to
indicate patient will be treated using Protura. Patient record will be added to Protura and will automatically
launch.

NOTE:

To set indicator if patient will be treated with Protura, refer to Section 5.1.3 Edit Patient Record.

2. Escort patient into treatment room and immobilize patient on couchtop as defined in treatment plan.
3. Inlinac IGRT System, Mode Up the setup field, as necessary.
4. Raise pedestal and move Protura to Zero Position by one of the following:

CLICK ZERO POSITION
IN PROTURA SOFTWARE CLICK ZERO IN REMOTE CONTROL SYSTEM

» = N
Zero Position

Move Load Zero Stop

Protura  WARNING nvuiat Zero

5. Align patient to external markers.
6. Exit treatment room.
7. Calculate shifts with linac IGRT System to align target.

NOTE For Elekta system configurations, Lock Pedestal Values in Protura software.
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8. Save shifts in linac IGRT System; these values will automatically populate in Protura.

9.
WARNING

Protura displays shift values and Move button becomes available.

N

Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

10. Click Move button to move Protura into treatment position.

11. Move Successful message will be displayed in Protura system. Click Yes to lock Protura for treatment.

Move Successful

o The move was successful. Is the patient ready for treatment?

FOR REMOTE CONTROL SYSTEM SHIFTS: (If no additional shifts are needed, continue with Step 12).
+ Click No to indicate patient is not ready for treatment and additional shifts are needed.

Move Successful

0 The move was successful. Is the patient ready for treatment?

Yes No

* Apply shifts with the Remote Control System.
NOTE:

Protura ignores the pedestal position being sent from the Remote Control System. Shift values are imported from the
IGRT system and appear as “Current Values” in Protura.

+ Click Move Protura in Remote Control System.

Mowve
Protura
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FOR REMOTE CONTROL SYSTEM SHIFTS (Cont.):

+ Change values to reflect current position of pedestal to match Protura and click Apply in Remote Control
System. With linac interface enabled, Protura will import and lock the pedestal location when shifts are sent
from the Remote Control System.

rent Position
0.0cm
100.0cm
0.0cm

0.0° ON

X &

+ Click Apply a second time to apply shifts in Protura.

Click 'Apply' to send the delta move to the Protura

Pedestal Location Protura Deltas

0.0cm
100.0cm

0.0 cm

0.0°

+ Click Verify to confirm shifts were applied correctly.

Click 'Verify' to check if the move was correct
Pedestal Location Protura Deltas
0.0cm
100.0cm
0.0cm

0.0°

NOTE:

If pedestal is not already locked, Varian system configurations require Mode Up the setup field prior to AlignRT move
to allow Protura to capture pedestal location.

A confirmation image is recommended to ensure patient and target are in the desired location before treatment is
delivered.
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12.

13.

14.
15.
16.
17.

18.
19.
20.

Ready for Treatment message will be displayed. System is now locked and ready for treatment.

Ready for-Treatment: X

® Ready for Treatment, system is Locked. To exit treatment mode, click UNLOCK.

UNLOCK

If additional shifts are required from Remote Control system, click UNLOCK and repeat Remote Control System
Steps. When ready for treatment, continue with Step 14.

FOR VARIAN SYSTEM CONFIGURATION:
* In OBI System, click Cancel and select No to apply shifts.

* In Varian 4DTC System, click Cancel to pedestal move request 0,0,0, which is sent from Protura to access
pedestal location.

* Mode Up treatment field.
NOTE:

Protura will lock during treatment with no option to unlock. Unlock option will be available at completion of each
treatment field.

@ Treatment may be in Process and system is Locked. This window will close when the

field is closed.

Follow treatment delivery protocol.

Enter treatment room.

Select UNLOCK in Protura.

Select Load / Unload button. Protura will move to Load / Unload position.

Load / Unload

Close patient in 4DTC or MOSAIQ, Remote Control System, and Protura software.
Patient may exit treatment room.

Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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6.8 Protura Workflow - File Import

This section details workflow using an Import file in Protura. Imported file will be in ASCII format.

1.

N ook ow

Escort patient into treatment room and with Protura in Load / Unload position, immobilize patient on couchtop as
defined in treatment plan.

Move Protura to Zero Position.

Zero Position

Align patient to external markers.

Exit treatment room.

Calculate shifts using an IGRT system to align target.
Export IGRT information to an ASCI| data file.

At Protura workstation, select Import button for direct access to Import data files. There are several options to
initiate the Import button.

+ From the File menu, click Import....
¢ Click Import in the Couch Position Panel.
¢ Select [Ctrl]+I on the keyboard.

If a patient is not loaded, Import will input patient data. If a patient is already loaded, Import will input IGRT data.
Import will verify if imported files match the imported patient. If they do not match, the user is given the option to import
or cancel.

Protura
File 10ls Reports Help
MR Number:

Patient Name: Edit Patient L — i~ e —
- L e —
Move Speed: eSSl Deauit (default)

Current Couch Pedestal Location ] Load / Unload
Lock Pedestal Values
P ———

Zero Position

Manual Motion Rotation adjustment enabled
Proposed Values Current Values

VERT 0.000 cm
LNG 0.000 cm

LAT 0.000 cm

YAW 0.00 deg

£
5
"5
4 |
o

I+

ROLL 0.00 deg

PITCH 0.00 deg
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8. Select file for import. File is imported and values are populated into MR Number, First Name, Last Name, Course,
Field, Couch Pedestal X Y Z Coordinate and six IGRT shift values.

Import ﬂm
Look e [ Impoet Exagle e N A

-~ Preview -

Patient Mame:  0Tonnor, Wiliam

MR Number.  Preview-01

Date of Shaft:  2/3/2003

Tine of Shift: 333 AM

TP File pame: [Freviewt sl 2 [gen |
Places
Filesof ype:  [IGRT Import Files( sl config) =] Cancel

NOTE MR Number, First Name and Last Name are required fields to save the patient record. If this information is missing from
import file, it will need to be entered (refer to Section 5.1.1 Create Patient Record).
Different oncology information systems and linac vendors use different file formats for exporting data. Please check with
CIVCO Customer Service to make sure the file format you are using is supported by Protura.
9. Click in each field of Current Couch Pedestal Location screen to confirm displayed values. Select Lock Pedestal
Values.
Current Couch Pedestal Location [ e —
Lock Pedestal Values
VERT LNG LAT Rotaton
cm em cm [ o
WARNING

ﬁ ®  Prior to selecting the Move button, verify pedestal and shift values in Protura match the IGRT system values.

10. Click Move button to move Protura into treatment position.
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11. Move Successful message will be displayed. Click Yes to lock Protura for treatment.

Move Successful

o The move was successful. Is the patient ready for treatment?

Yes No

NOTE A confirmation image is recommended to ensure patient and target are in the desired location before treatment is delivered.

12. Ready for Treatment message will be displayed.

Ready for: Treatment: X

® Ready for Treatment, system is Locked. To exit treatment mode, click UNLOCK.

UNLOCK

13. Follow treatment delivery protocol.

14. Upon completion of treatment, enter treatment room.

15. Select UNLOCK in Protura software.

16. Select Load / Unload button. Protura will move to Load / Unload position and automatically close patient record.

Load / Unload

17. Patient may exit treatment room.

18. Generate Patient Move Report in Protura software at completion of treatment. Save report in patient file as defined
in site protocol. Refer to Section 7.2 Patient Move Report.
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1 Reports

There are two types of Patient Reports:
+ Daily Move Report
+ Patient Move Report

Reports can be filtered on both patient and date criteria. These reports can be viewed, printed to paper or saved as PDF for
import into other information systems.

1. From the Reports menu, click Generate Patient Reports....

Generate Patient:Reporis

Report Type: e Patient Move Report Date Range: e All Dates
@ Daily Move Report LRI 11/8/2010  |is]
jI-l 11/8/2010
Patient(s):

Last Name: First Name: MR Number:

Last Name = First Name MR Number
Doe John 3195300265

Create Report Cancel

2. Select Report Type option.
3. Select appropriate Date Range option.
4. Select appropriate Patient(s) option.

NOTE Date Range defaults to Today.

Multiple contiguous rows can be selected by using [Shift]+click. Multiple non-contiguous rows can be selected
by using [Ctr]+click.

5. Click Create Report. The report will open in a new window titled Preview Report.

46



Reports

1.1

Daily Mo

ve Report

The Daily Move Report is generated when a single date is selected from Date Range option.

Daily Mov

e Report displays:
Generated Date
Protura Version

IGRT Coordinate System
IGRT Configuration Date
Moves performed on selected date (grouped by MR number then time)
Protura Location as defined in System Settings

Move Date

Patients are separated by shaded header containing IGRT system information.

#Protura

Date: Tuesday, May 14, 2013

IGRT Coordinate System: Default

Daily Move Report

Generated: Tuesday, May 14, 2013 13:43:11
Version

IGRT Ceonfiguration Date: Tuesday, May 14, 2013

Translation Start / Stop (mm) Rotation Start / Stop (deg)
Time Course/Field Last Name/MR # VERT LNG LAT YAW ROLL PITCH Trmt Manual
13:41 C2/F1 Doe [ 123-456-789 0/71 0/-42 | 0/-26 |0/-1.21 | 0/-256] 0/1.96 Yes No
13:40 c1/ Doe [ 123-456-789 0/2 0/28 0/19 | 0/229 | 0/0.55 | 0/1.22 Yes No
13:39 c1/ Doe / 123-456-789 0/086 0/138 0/53 | 0/228 | 0/086 | 0/1.04 No No
13:39 c1i Doe [ 123-456-769 5710 0/23 0/18 | 0/D48 [ 0D/148 |1 0/0.M1 No No
13:38 c1i Doe [ 123-456-789 5110 0/23 0/18 | 0/049 [ D/079 | 0/1.01 No No
13:38 C1/ Doe [ 123-456-789 51710 0/23 0/18 | 07048 [ 0/0.79 | 0/1.21 No No
13:35 XZ-test / Doe / MR-test-1 10/5 0/0 0/0 0/0 0/0 0/0 ‘Yes No
13:34 XZ-test / Doe / MR-test-1 0/10 0/0 0/0 (1] 0/0 0/0 ‘Yes No
Page 4 of 7
Type text to find... 4k

m
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1.2 Patient Move Report

The Patient Move Report is generated when All or From and To choices (with different dates) is selected from Date
Range option.

Patient Move Report displays:
+ Generated Date
¢ Protura Version
* MR Number
+ First Name
+ Last Name
+ Period

For each treatment date:
* IGRT Coordinate System
+ IGRT Configuration Date
* Protura Location as defined in system settings
* Move Date
* Moves performed (grouped by patient then location)

The Patient Move Report lists patient moves performed during the selected date range. Patients are separated by shaded
header containing patient information.

lE! L7 1
E
L ]
qiy» roillra ™ Patient Move Repon Generated: Tuesday, May 14, 2013 13:41:38
i Wersion:

MR Number: 123-456-789

First Name: John

Last Name: Doe

Period: Tuesday, May 14, 2013

IGRT Coordinate System: Default Move Date: Tuesday, May 14, 2013

IGRT Configuration Date: Tuesday, May 14, 2013

Protura Location: John's
Pedestal (cm) Pedestal Translation Start / Stop (mm}) | Rotation Start/ Stop (deg)
Time Course/Field VERT LNG LAT |Rot (deg){ Speed | VERT LNG LAT YAW ROLL | PITCH Trmt | Manual
13:41 C2/F1 & 35 0 0 High 0/71 | 0/-4210/-26 [0/-121]0/-256]0/1.96 Yes No
13:40 C1/ 10 30 1] 0 High 0/2 0/28 0/19 | 0/229 |0/0565]0/1.22 Yes No
13:39 Ci/ 100 400 0 0 High 0/06 | 0/18 | 0/563 [0/225|0/086]|0/1.04 No No
13:39 C1/ 100 400 0 0 High 5710 0/23 0/18 | 0/048 [0/149]0/0.71 No No
13:38 ci/ 100 400 0 0 High 5/10 | 0/23 | 0/18 [0/049]0/079]0/1.01 No No
13:38 C1/ 100 400 1] 0 High 57110 0/23 0/18 |0/048 [0/079]0/1.21 No No
Page 1071
v 0 4 F T
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1.3 Preview Report Overview

Preview Report Window is divided into three parts: Options, Report Body and Find.

—

—pi

Protura Location: John's
Date: Tuesday, May 14, 2013

IGRT Coordinate System: Default

Daily Move Report

Generated: Tuesday, May 14, 2013 13:43:11

IGRT Configuration Date: Tuesday, May 14, 2013

Version:

ype text to find...

Translation Start / Stop (mm} Rotation Start / Stop (deg)
Time Course/Field Last Name/MR # VERT LNG LAT YAW PITCH Trmt Manual
13:41 C2/F1 Doe / 123-456-789 0/71 0/-42 | 0/-26 |0/-121|0/-256 | 0/1.96 Yes. No
13:40 Cc1/ Doe / 123-456-789 0/2 0/28 | 0/19 | 0/229 | 0/055 [0/1.22 Yes No
13:39 C1/ Doe [ 123-456-789 0/06 | 0/18 | 0/53 | 0/223 | 0/086|0/1.04 No No
13:39 C1/ Doe [ 123-456-769 5710 0/23 0/18 [ 0/048 | 0/149 | 0/0.71 No No
1338 C1/ Doe [ 123-456-789 5/10 0/23 | 0/18 [ 0/049 ]| 0/079 [ 0/1.01 No No
13:38 Cc1/ Doe / 123-456-789 5710 0723 0718 | 0/048 | 0/079 | 0/1.21 No No
13:35 XZ-Aest/ Doe / MR-test-1 10/5 0/0 0/0 0/0 0/0 0/0 Yes No
13:34 XZAest/ Doe / MR-test-1 0710 0/0 0/0 /0 0/0 /0 Yes No
Page 4 of 7

n
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|. Options

Options are located in the upper-left corner of the window.

= e AREN ]

Saving a PDF

e

< shg

1. Click PDF icon. Save As window is displayed. Update filename and choose appropriate save destination. Click Save.

Print Report

,r"r

2. Click Printer icon. Print window is displayed. Choose appropriate print options. Click Print.
Copy Selected Text

1 Hw|
EEY

3. Highlight text to be copied ([CtriJ+A selects all text). Click Copy Selected Text icon. Paste text into desired
application.

Whole Page / Two Page Across

EEE

4. Change view options by selecting either Whole Page or Two Pages Across icons.
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Il. Report Body

This area contains details in the Daily or Patient Move Reports.

Time: Recorded time of move.

Course/Field: Selected Course and Field for move.

Last Name/MR #: Patient’s last name and MR # (Daily Move Report only).

Pedestal (cm or mm): Displays couch pedestal information (Patient Move Report only).

Pedestal Rot (deg): Displays degrees the pedestal was rotated (Patient Move Report only).

Speed: |dentifies selected move speed (Patient Move Report only).

Translation Start / Stop (cm or mm): Recorded Start and Stop locations for translation X, Y and Z axes, based upon IGRT
Coordinate System used.

Rotation Start / Stop (deg): Recorded Start and Stop locations for rotation U, V and W axes, based upon IGRT Coordinate
System used.

Trmt: Identifies if move resulted in treatment.

Manual: Identifies if move was done manually.

Daily Move Report
Translafion Start / Stop (mm) Rotation Start / Stop (deg)
Time Course/Field Last Name/MR # Lat Long Vert Pitch Roll Rin Trmt Manual
§:32 Course 1/ Doe /12345 0712 0/6 0/0 |o/40.375] 0/15 | 0/05 Yes Yes
9:31 Course 1/ Doe/ 12345 0/2 0/4 0i2 07101 J0/-045 ) 0/-069 Yes Mo
9:29 Course 1/ Doe/ 12345 0/5 0/12 0/ 0/05 0/1 0/0.01 Yes Mo
9.4 Tonsil / 1 Smith / 1234567890001 0/5 01 0/4 0/079 | 0/101 JO/-061 Yes No
Patient Move Report
Pedestal (cm) Pedestal Translation Start / Stop (mm) | Rotation Start / Stop (deq)
Time Course/Field vt Lng Lat |Rot{deg)] Speed Lat Long Vert Pitch Foll Rin Tmt | Manual
9:32 Course 1/ 20 145 0 0 Low 0/12 0/6 0/0 [07/D375) 0/15 | 0D/D5 Yes Yes
931 Course 1/ 20 145 0 0 Medium| 0/2 0i4 0/2 [0/101)0/049]0/-069] Yes No
929 Course 1/ 20 150 0 0 Medium| 0/5 0712 0/1 0/05] 01 0/0.1 Yes No

lll. Find

Find is located in the lower-left corner of the window. Find allows user to search report by key words. Down arrow allows
for different find options.
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The Protura application must be configured according to the specific setup of the treatment facility.

WARNING
f e Prior to clinical use, alignment is required to set Protura pivot point (refer to Section 8.4 Isocenter Alignment).

e Execution of QA tests is required during Protura installation and IGRT system configuration to assure proper results.
Failure to do so can result in patient mistreatment. Always verify shifts through re-imaging and verification and IGRT.

® Protura units are in millimeters and/or centimeters (as defined in Section 8.3 IGRT Coordinate System Configuration
and Section 8.2 Couch Pedestal Configuration). Ensure correct values when entered into the system.

From the Tools menu, click Configure....

The Configurations and Settings window is displayed. This panel contains six tabs:

+ System Settings

* Couch Pedestal Configuration

* IGRT Coordinate System Configuration
* Isocenter Alignment

¢ Elekta Interface Settings

¢ Varian Interface Settings

Configuration tabs are locked when window is opened. Click the LOCK to unlock settings.

To leave Configuration window without making changes, click Cancel.

A
Cancel

Enter Password window is displayed. There are two methods to enter password:
* Enter password (default password is CeePro, refer to Section 8.1 System Settings). Click OK.
+ Click the keyboard icon. Enter password using a mouse or touch screen (default password is CeePro, refer to
Section 8.1 System Settings). Click OK.

Enter-Password

passvors:
—

—
OK Cancel

NOTE Settings cannot be defined or updated if a patient file is open.

To leave Enter Password window without making changes, click Cancel.
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8.1 System Settings

System Settings tab contains:

Isocenter.Alignment Elekta Interface Settings Varian Interface Settings

System Settings ) Couch Pedestal Configuration , IGRTj Coordinate Systems

Last Modified Date:  Tuesday, May 14, 2013 13:46:52 )
sAlisy > Change Configuration Password

Time Display Format: Protura Location Name

® 12hr @ 24hr Protura

Patient Data Location Protura Port
S

C:\Patient Data Browse 50000

Import Files Location Protura Address
S

Import Time Threshold Protura Default Speed

ER i Remote Control I

DA e e n Remote Control IP Address

Remote Control Port

B Click to unlock settings

Time Display Format: Sets time display to 12 hour format or 24 hour format.

Patient Data Location: This directory is where all the patient data will be stored. If patient data is being shared among
multiple treatment rooms, a shared location accessible by all Protura applications is required. The files in this location
are used for generating reports, keeping a daily record of pedestal locations and shifts used for treatment. Click
Browse to locate directory.

NOTE Ensure all users have read/write access to directory where data is stored.

Import Files Location: This directory is where the Protura application Import window will default to for importing IGRT
move data. Click Browse to locate directory.

NOTE Data formatted in basic printable ASCII format (i.e., Patient Name, MR Number, Course and Field) can be imported from a
patient data management system and from an IGRT system (i.e., correction values), eliminating the need to manually
enter this data into the Protura System.

Import Time Threshold: This value (in minutes) will be used to compare date and time in IGRT import data to the
current system time. If IGRT date and time exceed the threshold value, a warning message will be displayed. This is to
reduce the chance of using obsolete IGRT data. Valid values range from 0 to 1500.

NOTE A value of “0” will skip the time threshold check.

Protura Default Speed: This value is the default movement speed for new patients and test procedure. The speed options
are Low, Medium and High.
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Protura Move Delay: This checkbox will delay Protura movement approximately 1.5 seconds after movement is
requested. This delay allows time between entering a shift into the software and the actual movement of Protura.

Change Configuration Password: Current password can be changed here. Password field must be at least four (4)
characters. This field accepts up to 30 characters and is case sensitive.

* Enter New Password (default password is CeePro).
* Re-enter password into Confirm New Password.
+ Click Save.

Ghange Password

New Password: [
Confirm New Password: _

Password must be at least 4 characters.

Cancel

+ Before leaving the Configurations and Settings window, click Save to ensure all changes are saved. To undo
any changes made, click Cancel. To leave without making changes, click Close.

WARNING
f e Execution of QA tests is highly recommended when changing the system configuration to assure proper results.

Failure to do so can result in patient injury.
Protura Location Name: This value uniquely identifies this particular instance of the Protura installation. If you have
more than one Protura in your department, this is where you would name the particular installation or linac room.

Protura Port: This value is the Protura hardware port number. Valid values range from 1 to 65535. This number is
uniquely assigned and should not be changed unless instructed by CIVCO Customer Service.

Protura Address: This value is the Protura hardware IP address. If you need to change the IP address for Protura,
please contact CIVCO Customer Service.

Remote Control: This checkbox will allow remote systems to connect to Protura and control it. Ensure at least one
IGRT configuration has an Access Key (refer to Section 8.3 IGRT Coordinate System Configuration/Remote Access
Key) specified prior to defining remote control.

Remote Control IP Address: Value for the Protura workstation IP address to the facility network is selected here. This
is the network Protura will communicate with for remote connection.

Remote Control Port: This value is the port number used for connecting remotely. Valid values range from 1024 to
65535.

NOTE When changing any previously saved configuration value, exit and restart the Protura application to apply changes.
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8.2 Couch Pedestal Configuration

The Couch Pedestal Configuration tab describes couch translation axes. Only one configuration can be set up per
Protura.

Isocenter.Alignment: } Elekta Interface Settings | Varian Interface Settings
System Settings \ Couch Pedestal(Configuration \ IGRY} Coordinate Systems:

Last Modified Date:  Tuesday, May 14, 2013 13:46:52
Translation Axes
Axis Label / Order / Direction Extents / Thresholds

Display Units “ Crossaver (cm)
stan /510p (cm)

Label / Display Order
[ 0 |

[ 0]
[ ] 500

Transiation Direction [ Thresholds (cm)

Pedestal Rotation Compensation

Pedestal Angle Threshold “ Couch angle increases when rolaied

90 270
REEHEVETIELC Rotation

Default Couch Pedestal Angle “ deg  when foot of table points away from gantry

Save Cancel Close

H Click to unlock settings

Axis Label / Order / Direction: The left image defines couch labels, display order, and to which direction the positive
and negative values refer. Axis labels accept up to five (5) characters and must be unique. These values should match
your Record and Verify system, linac text description and convention. The order should also be matched to minimize
errors.

Extents / Thresholds: The rightimage defines the range of motion and threshold values. To define the range of motion
for an axis, you must enter in three values: Start, Stop and Crossover. Find the values from the linac coordinate
convention. The Crossover field is the value where the pedestal range restarts from zero again. Axis threshold value
will be used to display a warning when one or more of the current Couch Pedestal Values, included in an IGRT import
file or manually entered, differ from the previous move for the course by more than the threshold value defined. Display
Units drop down list contains em and mm values and this determines the unit of measure.

For Example: a Start of 9,000 with a Stop of 3,000 and a crossover of 10,000 has a linear axis defined to be 9,000 to
10,000, 0 to 3,000.

NOTE A value of “0” will skip the threshold check.
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NOTE

NOTE

Pedestal Rotation Compensation: Defines Pedestal Angle Threshold, Default Couch Pedestal Angle and Angle
Rotation.

Pedestal Rotation Compensation 180

Pedestal Angle Threshold “ Couch angle increases when rotated
90 270
cwW -
Pedestal Rofation Label [liz{ejt1{{s]3]

Default Couch Pedestal Angle “ deg when foot of table points away from gantry

Pedestal Angle Threshold: This value (specified in degrees) will be used to display a warning when the current Couch
Pedestal Value, included in an IGRT import file or manually entered, differ from the previous move for the course, by
more than the threshold value defined.

A value of “0” will skip the threshold check.

Pedestal Rotation Label: This should match linac text description and convention. This value accepts up to eight (8)
characters.

Couch angle increases when rotated: Choose from CW (clockwise) or CCW (counter-clockwise) for angle calculation.
Verify intended angle direction is displayed correctly in image.

Default Couch Pedestal Angle: Choose appropriate longitudinal angle for pedestal orientation.

+ Before leaving the Configurations and Settings window, click Save to ensure all changes are saved. To undo
any changes made, click Cancel. To leave without making changes, click Close.

Cancel Close

o

When changing any previously saved configuration value, exit and restart the Protura application to apply changes.
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8.2.1 Couch Pedestal Configuration Relationship

Current Couch Pedestal Location (left image) are displayed in the following order: Vert, Long and Lat. This display order
is defined in Configurations and Settings. (right image)

Axis Label / Order / Direction

Current Couch Pedestal Location

Lock Pedestal Values

en @)

Label / Display Order

From Tools menu,

click Configure...

click Couch Pedestal Configuration.
Unlock the settings.

Change Display order for Vert from 1 to 2, Long automatically changes to 1.
Change Display order for Long from 1 to 3 and Lat automatically changes to 1.
Click Save.

Changes are displayed on the main window:

Axis Label / Order / Direction

Label / Display Order

3 )

Current Couch Pedestal Location
Lock Pedestal Values

Transtation Direction  [[Rg

NOTE When changing any previously saved configuration value, exit and restart the Protura application to apply changes.
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8  Configurations and Settings

8.3 IGRT Coordinate System Configuration

IGRT Coordinate Systems tab is where one or more IGRT Coordinate Systems are defined. The IGRT Coordinate System
definition can be configured to match treatment and imaging equipment setup, enabling easy entry of IGRT move data.

+ Select different IGRT Coordinate System from drop list.
+ Create new system, or edit or delete an existing system.
+ Select a current system from the drop list to view configuration settings.

Isocenter.Alignment Elekia Interface Settings - Varian Interface Settings

System Settings | oSG A I M e 7 IGRTiGoordinate Systems:
IGRT Coordinate System: m Rotation Order
Default (default) - Angle Type

Rotation Axis Labels / 2ric

Remote Access Key:

T.onelation Axis Labels / Order

Label/ Display Order Label / Display Order

R

=

Translation Direction Rotation Direction
IGRT Coordinate System Name: B Setas Defauit System

IGRT Coordinate System Data Type: B Couch Rotation Compensation

Save Cancel Close

H Click to unlock settings

The use of an incorrect IGRT Coordinate System can lead to mistreatment. Care should be taken to ensure the
correct IGRT Coordinate System is used for each patient. For example, the user may rely on an optical based IGRT
system and periodically perform a CBCT for alignment. If the two IGRT systems have different coordinate systems
or outputs, the user must make sure the correct system is selected for treatment.
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8  Configurations and Settings

IGRT Coordinate System: A new IGRT Coordinate System can be created or a current system can be edited or deleted.

CREATE NEW SYSTEM:

Click Create New System to create a new system.
Enter required data.

Click Save once all information is completed.

EDIT:

Select system from drop down list.

Click Edit to change configuration settings.
Click Save once all information is completed.

DELETE:

Select the IGRT Coordinate System from drop down list to be deleted.
Click Delete.

A window will display to confirm deletion. Click OK.

Isocenter.Alignment . Elekta Interface Settings | Varian Interface Settings
System Settings \ Couch Pedestal Configuration ' |GRT Coordinate Systems!

IGRT Coordinate System: < m \ Rotation Order
Default (default) - Angle Type

Remote Access Key: _ Edit Delete Display Units

Translation Axis Labels / Order Rotation Axis Labels / Order

Label / Display Order Label / Display Order

9

=

Translation Direction Rotation Direction
IGRT Cocrdinate System Name: JSEIEII B Set as Default System

IGRT Coordinate System Data Type: B Couch Rotation Compensation

Remote Access Key: Allows an approved remote system to connect with Protura. Move data will be reported using
this IGRT configuration. This field accepts up to 10 characters and must be unique.

Rotation Order: Determines the order of axis rotation. Drop down list contains all X-Y-Z value combinations.
Angle Type: Determines the type of angle. Drop down list contains Fixed and Euler values.
Display Units: Determines the unit of measure. Drop down list contains em and mm values.

Translation Axis Labels / Order and Rotation Axis Labels / Order: Values can be entered into axis labels, display
order Translation Direction can be selected. Axis labels accept up to five characters and must be unique.

IGRT Coordinate System Name. This field accepts up to 20 characters and must be unique. Default system can be
set by selecting checkbox by Set as Default System.

NOTE Changing the IGRT Coordinate System Name requires a restart of P